
                    [image: alt]
                
        
            
                                        
        
        
    

    
        

    



    
                
        
            
                
                    Support

                    Log in

                
            

        

        
            
                
                    
                        
                            

                            

                            

                        

                    

                    
                                                    
                                [image: pdfFiller logo]
                            
                                            

                    
                        
                            
                                Solutions

                                
                                    
                                        
                                            
                                                Solutions

                                                Discover how pdfFiller helps teams process documents faster, collect data and approvals, and more.

                                            

                                            
                                                By business size

                                                
                                                    Enterprise

                                                    Individuals + SMBs

                                                
                                                By integration

                                                
                                                    Salesforce

                                                    Google add-ons

                                                    Google extensions

                                                    All integrations

                                                
                                            

                                            
                                                By industry

                                                
                                                    Healthcare

                                                    Financial services

                                                    Education

                                                    Legal

                                                    Software and IT

                                                    Real Estate

                                                    Government

                                                    See all

                                                
                                            

                                            
                                                By use case

                                                
                                                    Patient intake and follow up workflow

                                                    Managing sales proposals, quotes, and invoices

                                                    Real estate agreements workflow

                                                    Employee onboarding workflow

                                                    HIPAA authorization form workflow

                                                
                                            

                                        

                                    

                                

                            

                            
                                Developers

                                
                                    
                                        
                                            
                                                Developers

                                                Learn how to integrate PDF editing, sharing, and document creation into your software.

                                            

                                            
                                                
                                                    PDF Tools API

                                                    API documentation

                                                    API pricing

                                                
                                            

                                            
                                                
                                                    Robust PDF Tools API
for all your document needs

                                                    Talk to sales

                                                

                                            

                                        

                                    

                                

                            

                            Features

                            Pricing

                        
                    

                                            
                                                            
                                Start Free Trial
                                


                                

                                
                                                    

                                    

            

        

    
            
        

        
            
                

                We use cookies to improve security, personalize the user experience, enhance our marketing activities (including cooperating with our marketing partners) and for other business use. Click here to read our Cookie Policy. By clicking “Accept“ you agree to the use of cookies. ... Read moreRead less

            

            
                Accept
            

        

    




    


                    
    
        
            
                
                    Solutions

                    
                        
                            
                                By business size

                                
                                    Enterprise

                                    Individuals + SMBs

                                
                                By integration

                                
                                    Salesforce

                                    Google add-ons

                                    Google extensions

                                    All integrations

                                
                            

                            
                                By industry

                                
                                    Healthcare

                                    Financial services

                                    Education

                                    Legal

                                    Software and IT

                                    Real Estate

                                    Government

                                    See all

                                
                            

                            
                                By use case

                                
                                    Patient intake and follow up workflow

                                    Managing sales proposals, quotes, and invoices

                                    Real estate agreements workflow

                                    Employee onboarding workflow

                                    HIPAA authorization form workflow

                                
                            

                        

                    

                

                
                    Developers

                    
                        
                            
                                
                                    PDF Tools API

                                    API documentation

                                    API pricing

                                
                            

                            
                                
                                    Robust PDF Tools API
for all your document needs

                                    Talk to sales

                                

                            

                        

                    

                

                Features

                Pricing

                Support

            
        

        
            
                Log in
            

        

    



                            

            
                                            
            

            
                
            
    
        
                	
                    
                        Home
                    
                
	
                    
                        Functionality index
                    
                
	
                    
                        PDF Converter: Convert PDF to Editable
                    
                
	
                    
                        Modify PDFs into a format you need
                    
                
	
                    PDF to Oft
                


    
        

        
                        Convert PDF to OFT Online in Seconds For Free
                    

                    
        
            

        

                    

    



    


                            Note: Integration described on this webpage may temporarily not be available.

            

        Today AUG 18TH, 2022*

        
            
                
                    
                        

                        
                            0

                            Forms filled

                        

                    

                

                
                    
                        

                        
                            0

                            Forms signed

                        

                    

                

                
                    
                        

                        
                            0

                            Forms sent

                        

                    

                

            

        

    




        
    
        
            
                
                    
                        
                        
                        [image: Function illustration]
                    
                    
                                                    Upload your document to the PDF editor
                                            

                

            

            
                
                    
                        
                        
                        [image: Function illustration]
                    
                    
                                                    Type anywhere or sign your form
                                            

                

            

            
                
                    
                        
                        
                        [image: Function illustration]
                    
                    
                                                    Print, email, fax,  or export
                                            

                

            

            
                
                    
                        
                        
                        [image: Function illustration]
                    
                    
                                                    Try it right now! Edit pdf
                                            

                

            

        

    


        
    
        Users trust to manage documents on pdfFiller platform

        
                                                
                        65.5K+

                        documents added daily

                    

                                    
                        53%

                        of documents created 
from templates
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per month
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                                                                        Our Convert PDF to OFT feature is designed to make your life easier by providing a simple and efficient solution for converting PDF files to OFT format.

                                                                                                Key Features

                                                                                                
                                                                    
                                        User-friendly interface for easy navigation

                                    

                                                                    
                                        Effortlessly convert PDF files to OFT format

                                    

                                                                    
                                        Preserve the original formatting and layout of the PDF

                                    

                                                                    
                                        Support for batch conversion to save your valuable time

                                    

                                                                    
                                        Option to customize the converted OFT files according to your preferences

                                    

                                                            

                                                                                                Potential Use Cases and Benefits

                                                                                                
                                                                    
                                        Seamless integration with email marketing platforms, allowing you to create stunning email templates

                                    

                                                                    
                                        Simplify the process of converting PDF-based forms into OFT format for use in popular email clients

                                    

                                                                    
                                        Save time and effort by quickly converting PDF brochures, catalogs, and newsletters to OFT format

                                    

                                                                    
                                        Improve productivity by automating the conversion process for large-scale projects

                                    

                                                                    
                                        Enhance communication and brand consistency by using customized OFT templates

                                    

                                                            

                                                                                                With our Convert PDF to OFT feature, you can easily solve the problem of converting PDF files to OFT format without losing any formatting or layout. Whether you need to create eye-catching email templates or convert PDF forms for email campaigns, our feature has got you covered. Save time, streamline your workflow, and enhance the visual appeal of your communications with our user-friendly and efficient converter.

                                                            

            

        

    
    
    
        
            
                All-in-one PDF software
            

            
                A single pill for all your PDF headaches. Edit, fill out, eSign, and share – on any device.
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        Instructions and Help about Document PDF Doc
    


            Convert PDF to OFT: full-featured PDF editor

                At some point in time, almost everyone has ever needed to work with a PDF document. For example, an affidavit or application form that you need to submit online. If you collaborate on PDFs with others, and if you need to ensure the accuracy and precision of shared information, use PDF editing tools. You only need a PDF editor to apply any changes to your document: add more text, rewrite the existing one, attach media or fillable fields.

                Using pdfFiller, add text, spreadsheets, pictures, checkmarks, edit existing content or create entirely new documents. Once finished, save it as a PDF file, or export to the platform you're using with built-in integration's features. Convert PDFs into Excel sheets, images, Word files and much more.

                Sign documents digitally using e-signature, which you can create with your mouse or touchpad, or upload from a photograph. This functionality is available on both desktop and mobile devices, and is verified across the United States (under the E-Sign Act of 2000). Use an existing digital signature (scan it from your device, or take a photo), type it manually.

                Use powerful editing tools to get professional-looking documents. Cloud storage is available on any device and to provide the high-level security for your data.

                Create documents from scratch. Add and edit text, signature fields, checkboxes and more

                Fill out fillable forms. Browse the template library to select the ready-made form for your needs

                Edit PDF files online. Change the content or mix it up with images, apply watermarks or add checkboxes

                Change the format. Convert PDF files to any document format including Word, Excel, Google Docs, Pages and more

                Protect with password. Encrypt your files with two-factor authentication
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                            Cancel Circle in the Profit Sharing Plan with ease
                        

                                            
                            Cancel Circle in the Business Proposal Template UK with ease
                        

                                            
                            Cancel Circle in the Sales Proposal Template with ease
                        

                                            
                            Cancel Circle in the Software Development Agreement Template with ease
                        

                                            
                            Cancel Circle in the Construction Equipment Lease Proposal Template with ease
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        How to Use the Convert PDF to OFT Feature
    


            Converting PDF files to OFT format can be done easily with pdfFiller. Follow these simple steps to make the most of the Convert PDF to OFT feature:

                
                        
                                    01

                    
                        Login to your pdfFiller account. If you don't have an account yet, sign up for free.
                    

                            

                        
                                    02

                    
                        Once logged in, click on 'My Forms' at the top of the page to access your saved PDF documents.
                    

                            

                        
                                    03

                    
                        Select the PDF file you want to convert to OFT format by clicking on it.
                    

                            

                        
                                    04

                    
                        After selecting the PDF file, click on the 'More' button located at the top right corner of the page.
                    

                            

                        
                                    05

                    
                        From the dropdown menu, choose the 'Convert to OFT' option.
                    

                            

                        
                                    06

                    
                        A pop-up window will appear, allowing you to customize the conversion settings. You can choose the page range, adjust the layout, and add any necessary fields.
                    

                            

                        
                                    07

                    
                        Once you have customized the settings, click on the 'Convert' button to start the conversion process.
                    

                            

                        
                                    08

                    
                        Wait for the conversion to complete. The time required may vary depending on the size of the PDF file.
                    

                            

                        
                                    09

                    
                        After the conversion is finished, you will be able to download the OFT file to your computer or save it directly to your pdfFiller account.
                    

                            

                        
                                    10

                    
                        Congratulations! You have successfully converted a PDF file to OFT format using pdfFiller's Convert PDF to OFT feature.
                    

                            

                    

                By following these steps, you can easily convert your PDF files to OFT format and make them compatible with Outlook email templates. Enjoy the convenience and efficiency of pdfFiller's Convert PDF to OFT feature!

            

    
        
        
            
                 More information

In a post on the Windows Blog, a Microsoft engineer wrote “One of the most frequently asked questions we get from developers is how to generate a PDF file from their application. Many developers would be very happy to just generate a PDF and use that from the command line, but the fact is, PDF is an incredibly complex document format and generating even a small single page of it is not possible when working with .NET. To make it easier, we wrote the following tool that will not only generate a single page document, but the entire PDF document. If you want to learn more about making your own PDF files, take a look at “Making Text and Graphics with Visual Studio” and “How to create a simple .NET application with Roslyn” Microsoft Techno and Microsoft Research have other great articles on creating PDF documents. Microsoft has also written about the .NET PDF library in great detail at Microsoft Research The Microsoft SDK for PDF, for example, lets the user generate PDF documents from Visual Studio applications in a programmable way using the PDF.NET library. Find PDF to oft’ right on your desktop

Get fast access to free PDF document editing, copy & paste, formatting and merging on any device, with the addition of the ability to open documents stored on any type of media including cloud services like Skydive. We can't cover all the different uses and benefits PDF to oft’ has, but here are a few:

Save document data between your device and a cloud service such as Skydive

Save document data across multiple devices

Save document data from multiple cloud services

Copy and paste your document from one place to another

Add comments

Export large PDF documents to other cloud services

Copy and paste your document directly to word documents (excel, doc, DOCX and PPT)

Add attachments

Share or copy your document to different cloud services

Add a signature to your document. Excel, Doc, DOCX, DOC, PPT, and other document formats are supported

Share multiple documents from one email account

Add more pages for viewing as well as attach them.
            

        

    
            
    
        What our customers say about pdfFiller

        See for yourself by reading reviews on the most popular resources:
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                        648 Reviews
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                            4,6

                        

                        661 Reviews
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                            4,4

                        

                        95k Reviews
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                            4,6

                        

                        9k Reviews

                    

                

        

                    
                                    
                        
                            
                                
                                    Nate

                                    

                                

                                
                                    2018-02-06

                                

                            

                            
                                
                                    PDF filler has been fantastic for me as a small business owner. It truly is the one stop shop for all my business document needs. They handle everything expertly. Totally takes out the stress of filling out documents and sending them to the IRS. I can just fill them out and click my way through the process with ease.
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                                    Juan M

                                    

                                

                                
                                    2019-12-10

                                

                            

                            
                                
                                    it was a great experience. But im not a business and only need was to keep track of all my medicines. the military clinic will provide me with a blank form for this purpose.thanks for allowing me the use of the free 30 days trial.
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                    Get a powerful PDF editor for your Mac or Windows PC

                    Install the desktop app to quickly edit PDFs, create fillable forms, and securely store your documents in the cloud.

                    
                        Download pdfFiller for Mac OS

                        Download pdfFiller for Windows PC
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                    Edit and manage PDFs from anywhere using your iOS or Android device

                    Install our mobile app and edit PDFs using an award-winning toolkit wherever you go.

                    
                        Download from App Store

                        Download from Google Play
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                    Get a PDF editor in your Google Chrome browser

                    Install the pdfFiller extension for Google Chrome to fill out and edit PDFs straight from search results.

                    Download from Chrome Web Store

                

            

        

    


    
    
        
            
                
                    pdfFiller scores top ratings in multiple categories on G2
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                Did you know?
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                        API for converting email OFT files to PDF files. Use this API to test API request. Convert email header and email attachments. Store converted file on our secure server and provides download URL. Set WebHook URL to call after conversion is finished. Embed fonts in PDF.


                    

                            

        

    
    
    
        
            List of extra features
        

        
                            
                    Convert PDF to X online
                

                            
                    Convert PDF to XFDF online
                

                            
                    Convert PDF to XMCT online
                

                            
                    Convert PDF to BZZ online
                

                            
                    Convert PDF to 602 online
                

                            
                    Convert PDF to ALD4 online
                

                            
                    Convert PDF to CNV online
                

                            
                    Convert PDF to GP5 online
                

                    

    


        
        
            
                                    For pdfFiller’s FAQs
                            

            
                                    Below is a list of the most common customer questions. If you can’t find an answer to your question, please don’t hesitate to reach out to us.
                            

            
                                    
                        
                            
How do I save an email in Gmail as a file?
                        

                                                    Download emails to your computer On your computer, go to Gmail. Open the email. Click More . Click Download message.

                                            

                                    
                        
                            
How do I open a .OFT file without Outlook?
                        

                                                    File Viewer Plus can open OFT (Outlook email template) files. It allows you to view email message templates, and convert them to other formats, such as EML, MSG, and HTML. Open OFT files without Microsoft Outlook.

                                            

                                    
                        
                            
How do I convert an oft file?
                        

                                                    Steps to Convert OFT or Outlook Template File  and Run Outlook File Template Converter. Click on the Browse button and select the OFT files. Tick the folder and preview the emails data with attachments. Select the saving file format or Webmail option from the interface. Now, choose the required software features.

                                            

                                    
                        
                            
How do I convert OFT to Word?
                        

                                                    C++ API to Convert OFT to WORD Open OFT file using MailMessage class reference. Convert OFT to HTML by using Save member function. Load HTML by using Document class. Save the document to DOCX format using Save method and set Docx as SaveFormat.

                                            

                                    
                        
                            
How do I convert from OFT to Outlook?
                        

                                                    1 – Start Microsoft Outlook personal information manager (PIM) program and choose a New Email option. 2 – Fill and write information in Outlook email template like To, Cc, Bcc, Subject, Text Information, HTML Links, Images, etc. After that press the File button to continue.

                                            

                                    
                        
                            
How do I save an oft as a PDF?
                        

                                                    Open Word and choose File > Open. Select the HTML file you saved in step 4. Choose File > Save As, and then choose PDF (*. pdf) from the file type drop-down before choosing Save.

                                            

                                    
                        
                            
How to turn a PDF into an OFT?
                        

                                                    Choose Edit > Preferences > Convert From PDF. Choose a format from the Converting From PDF list, and then click Edit Settings. Choose the conversion settings, and then click OK.

                                            

                            

        

                                                                                                                        
    
    
    
    
        
            

            
                eSignature workflows made easy
            

            
                Sign, send for signature, and track documents in real-time with signNow.
            

            
                
                    Start free trial
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            Email
            
        

        
            Country
            Select your country
Afghanistan
Åland Islands
Albania
Algeria
American Samoa
Andorra
Angola
Anguilla
Antarctica
Antigua & Barbuda
Argentina
Armenia
Aruba
Australia
Austria
Azerbaijan
Bahamas
Bahrain
Bangladesh
Barbados
Belarus
Belgium
Belize
Benin
Bermuda
Bhutan
Bolivia
Bosnia & Herzegovina
Botswana
Bouvet Island
Brazil
British Indian Ocean Territory
British Virgin Islands
Brunei
Bulgaria
Burkina Faso
Burundi
Cambodia
Cameroon
Canada
Cape Verde
Caribbean Netherlands
Cayman Islands
Central African Republic
Chad
Chile
China
Christmas Island
Cocos (Keeling) Islands
Colombia
Comoros
Congo - Brazzaville
Congo - Kinshasa
Cook Islands
Costa Rica
Côte d’Ivoire
Croatia
Cuba
Curaçao
Cyprus
Czechia
Denmark
Djibouti
Dominica
Dominican Republic
Ecuador
Egypt
El Salvador
Equatorial Guinea
Eritrea
Estonia
Eswatini
Ethiopia
Falkland Islands
Faroe Islands
Fiji
Finland
France
French Guiana
French Polynesia
French Southern Territories
Gabon
Gambia
Georgia
Germany
Ghana
Gibraltar
Greece
Greenland
Grenada
Guadeloupe
Guam
Guatemala
Guernsey
Guinea
Guinea-Bissau
Guyana
Haiti
Heard & McDonald Islands
Honduras
Hong Kong SAR China
Hungary
Iceland
India
Indonesia
Iran
Iraq
Ireland
Isle of Man
Israel
Italy
Jamaica
Japan
Jersey
Jordan
Kazakhstan
Kenya
Kiribati
Kuwait
Kyrgyzstan
Laos
Latvia
Lebanon
Lesotho
Liberia
Libya
Liechtenstein
Lithuania
Luxembourg
Macao SAR China
Madagascar
Malawi
Malaysia
Maldives
Mali
Malta
Marshall Islands
Martinique
Mauritania
Mauritius
Mayotte
Mexico
Micronesia
Moldova
Monaco
Mongolia
Montenegro
Montserrat
Morocco
Mozambique
Myanmar (Burma)
Namibia
Nauru
Nepal
Netherlands
New Caledonia
New Zealand
Nicaragua
Niger
Nigeria
Niue
Norfolk Island
North Korea
North Macedonia
Northern Mariana Islands
Norway
Oman
Pakistan
Palau
Palestinian Territories
Panama
Papua New Guinea
Paraguay
Peru
Philippines
Pitcairn Islands
Poland
Portugal
Puerto Rico
Qatar
Réunion
Romania
Russia
Rwanda
Samoa
San Marino
São Tomé & Príncipe
Saudi Arabia
Senegal
Serbia
Seychelles
Sierra Leone
Singapore
Sint Maarten
Slovakia
Slovenia
Solomon Islands
Somalia
South Africa
South Georgia & South Sandwich Islands
South Korea
South Sudan
Spain
Sri Lanka
St. Barthélemy
St. Helena
St. Kitts & Nevis
St. Lucia
St. Martin
St. Pierre & Miquelon
St. Vincent & Grenadines
Sudan
Suriname
Svalbard & Jan Mayen
Sweden
Switzerland
Syria
Taiwan
Tajikistan
Tanzania
Thailand
Timor-Leste
Togo
Tokelau
Tonga
Trinidad & Tobago
Tunisia
Turkey
Turkmenistan
Turks & Caicos Islands
Tuvalu
U.S. Outlying Islands
U.S. Virgin Islands
Uganda
Ukraine
United Arab Emirates
United Kingdom
United States
Uruguay
Uzbekistan
Vanuatu
Vatican City
Venezuela
Vietnam
Wallis & Futuna
Western Sahara
Yemen
Zambia
Zimbabwe
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0 - 5 employees
6 - 50 employees
51 - 200 employees
201 - 1000 employees
1001 - 2000 employees
2001 +  employees


        

        
            Questions or Comments
            
        

        
                                                By clicking “Talk to sales” I agree to receive email or phone communications about your services, offers, and promotions. We use your information as described in our Privacy Notice
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